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Document Introduction

This document is intended for persons who install and upgrade software for FX Supervisory
Controllers.

This document describes the detailed procedures for upgrading FX Workbench 6.x and earlier, the
steps for migrating to FX Supervisory Software 14.x., and the steps for upgrading from earlier 14.x
software to the latest 14.x version.

Product discontinuations

FX Supervisory Controllers and FX Server are all built upon a software framework called Niagara®.
Niagara integrates diverse systems and devices, regardless of manufacturer or communication
protocol, into a unified platform that you can manage in real time using a standard Web browser.
The Niagara Framework has evolved to the point where you must migrate any existing, upgradable,
Niagara™ platforms and stations (that is, any FX software release prior to 14.0) to a later release -
FX 14.10.0 is strongly recommended. The final date to order Niagara™ is June 1, 2021 and from July
1, 2021, no new licenses or option parts will be created or sold for any release prior to 14.0.

» Important: You cannot upgrade older supervisory controllers, such as the FX70 and FX60s, to
any FX software release later than 14.4.

Table 1: Migration scenario

Scenario Steps

* Prior to July 2023, you can purchase a license for
your supervisor and migrate the supervisor to the

If you are operating on a system that latest software release.

runs on any FX software release prior to

14.0 and you need to replace or add an * You will also need to migrate the station of the

FX80 after July 2021. FX80 you are.replacmg to.the latest spftvyare
release, and install the migrated station into the
FX80.

Concepts

Ordering codes for Europe, Middle East, and Africa

Multiple ordering code sets have been introduced, to allow the tailoring to regional needs. All
products on a given order must come from the same set. To determine the correct code for your
region, complete the following steps:

1. Use the following table to first determine the proper product code set to use:
Table 2: Product code set

Product Code Set | Notes

Base The original FX product codes

Base+E Use this new set of codes only for the region(s) specified in Table 3.

2. Use the following table to determine the correct product code set for your region:
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Table 3: Regional ordering information

Region Product Code Set

North America

Latin America, South America Base

Asia

Middle East

Africa Base+E

Europe

FX Supervisory Controllers

FX Supervisory Controllers describe a family of hardware products.

The FX80 and the F4-SNC are the only actively manufactured controllers and recommended to
use in every new installation. For futher information on the F4-SNC, refer to the F4-SNC Product
Bulletin (LIT-12013699).

The FX20, FX40, FX60 are all no longer available to order and should be replaced with an FX80.

The FX30, FX60E, and FX70 have been discontinued and while they are still available to order,
they are now at the end-of-life stage. It is strongly recommended that an FX80 is ordered
instead.

Table 4: FX Supervisory Controller upgrade scenarios

Scenario

Your system includes an FX20 and/or FX40.

These supervisory controllers must be replaced
with an FX80. Refer to the FX80 Supervisory
Controller Product Bulletin (LIT-12012250) for
ordering information.

Your system includes an FX30, FX60, FX60E, FX70 |upgrade to the latest software release.

It is strongly recommended to replace these
supervisory controllers with an FX80 and

running FX software release 6.x. See Detailed Procedures for Migrating to
FX Supervisory Software 14.x for further
information.
Your system includes an FX80 running FX It is strongly recommended to upgrade to the
software release 6.x or an unsupported version |latest software release. See Upgrading the FX
of software release 14.x Workbench Software for more information.

FX Server

The FX Server software product is available for various computer platforms and provides:

Network integration of one or more for Facility Explorer 14, FX Supervisory Controllers, or IP-
based devices (without any FX Supervisory Controllers).

Network-wide automation and coordination for one or more FX Supervisory Controllers
through master scheduling, and centralized, long-term, high-capacity storage of alarms and
trends.

Centralized, network-wide, web-based, graphical user interface for one or more FX Supervisory
Controllers supporting both local and remote access.
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(Release 6.x) FX Supervisor Controller Family Software DVD
(LP-FXWB-COPY)

This product and the associated 6.x software has now been discontinued. Copies of FX Workbench
6.3 to 6.7 are available for migration purposes on hvacnavigator.com. 14.x Workbench licenses
come with a 6.x license which will also enable you to run Workbench 6.x for migration purposes.
See Migrating the 6.x Station to Facility Explorer 14.x for more information.

Upgrading

Upgrading is the process of installing new software onto your computer, onto an FX Supervisory
Controller, or both.

Migration

Migration is similar to upgrading, but signifies a larger change in software. Migration typically
requires more steps and conversions to move forward.

Upgrade Pricing Policy

A 1 year minimum maintenance is required with any new FX Server or FX80 purchase. Maintenance
can be purchased in 1, 3, or 5-year increments. With each maintenance plan, you have access to any
new software developed during that time. If you let the maintenance lapse, and want it later, you
must buy the maintenance you missed plus the new maintenance.

Software Revision Numbering

All FX Supervisory Controller, FX Server, and FX Tools Supervisor software products incorporate an
instance of Niagara software. See the following table to find which revision of the Niagara software
is used in each FX Supervisory software release.

» Important: Software version 14.4 is the final 14.x release that supports the FX30E, FX60E, and
FX70. After 14.4, the 14.x releases only supports the FX80. For a full overview of the supported
versions of hardware and FX / Niagara software, see Historical software revision numbering.

Table 5: Software numbering

Niagara base examples FX equivalent

FX appends a 1 to the base Niagara release so

4.9 the equivalent software release for FXis 14.9

FX appends a dot release to distinguish when
N/A there are multiple FX releases against a given
Niagara release. As an example, 14.9.1

FXincrements a Niagara update release to the

4.9U1 base example. As an example, 14.9.2
FX adds its own specific features against the
N/A base Tridium update release. As an example,

14.9.3
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Table 6: Niagara version used

Niagara
SR Key Identifying Features or Changes Software
Versions
Major release that allows FX Workbench to run on the Niagara
4 platform.
14.0 4.0.22.16
The jump from 6.x to 14.x was intentional to align with the
Niagara software version moving forward.
14.1 Major release that adds support for FX80 Supervisory 4.1.27.20
Controllers
Major release that adds Analytics 2.0 to FX Workbench. There is
14.2 also support for the Alarm Portal, more robust FX Server data |4.2.36.38

management features, and support for FX80 legacy drivers.

Major release that introduced two new RIO modules. The
14.3 release also adds new HTML5 screens to FX Workbench and 4.3.58.18
improved mobile web device functionality.

Major release adding new HTMLS5 screens to FX Workbench,
improving mobile web device functionality. Minor change

to the User Service making the scheduled access for users
available through the User Details section. The JCI User
manager has been removed. Updating an existing Nav file is
through the Tools menu. This is the last release that supported
legacy supervisory controllers such as the FX30, FX60, and
FX70.

14.4 4.4.73.6

Minor release that provides eighteen functional fixes. These
included updated firmware to solve FX80 WIFI modem failure,
a fix to Niagara Daemon Engine Watchdog, and fixes to
14.4U1 lexicons, hyperlinking, scrolling, and adding notes. 4.4.92.2

There was also internationalization fixes to lexicons and
locales along with web fixes to PDF Export, Webchart, popups,
PxIncludes and HTMLS5 property sheets.

Major release that provides a number of updates and fixes.
14.6 These include Auto Export, a feature only available on Facility |4.6.96.28
Explorer®, cybersecurity fixes and a mobile refresh update.

Major release that provides new provisioning steps for
common processes, a new template type called 'Application
Templates', and a secondary JACE port that supports the DHCP
server.

14.7.0 4.7.109.20.3

Minor release that provides a number of new FX features.
These include extending 14.7 with automatic meta-data
14.7.2 tagging of applications, a HTML5-based Point-Extension- 4.7.109.20.3
Manager, point groups and a point-group-manager driven by
data tags, and the launch of CCT 13.0, replacing PCT.
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Table 6: Niagara version used

Niagara
SR Key Identifying Features or Changes Software
Versions

Major release that provided support for Niagara 4.8. This
release provides a new Niagara dashboard to quickly assess
the security posture of your network, 802.1-x support for
network access authentication, and the use of client certificate
authentication to enable kiosk mode and station-to-station
connectivity.

14.8.0 4.8.110.5

Minor release that provides a number of new features. These
include an enhancement to the Auto Tagging feature, the
inclusion of Jar file signatures, TEC3000 color compatibility, and
additional security fixes.

14.9.1 4.9.0.198

Minor release that provides a number of new features. These
include an enhancement to the graphics with tag-based
visualization, the inclusion of Single Sign-On (SSO), improved
Edge tools, and additional security fixes.

14.9.2 4.9.1.30.2

Major release that provides a number of new features. These
include a system database support for Tag-based PX, improved
14.10.1 graphics performance on the FX80 Supervisory Controller, a 4.10.0.154.3
new video surveillance viewer, and additional tags and tag
groups added to the jciTagDictionary.

Software License Agreement

All Johnson Controls software is licensed. During the installation process, you must accept or
decline the terms of the software licensing agreement.

Preventing Unauthorized Software Duplication or Usage

Johnson Controls, Inc. uses the following two methods to prevent unauthorized software
duplication and usage.

+ Acceptance of the terms of the software licensing agreement legally prohibits duplicating or
using Johnson Controls Facility Explorer software tools without authorization. This method
applies to all Johnson Controls Facility Explorer software.

« A properly formatted and installed license file (FacExp.license) is required to enable the
operation of FX Workbench, FX Workbench Pro, FX Alarm Portal, and FX Server.

® Note: At Release 14.0 and later, a new Johnson.license is required to enable the operation of
the N2 driver.

License Files

License files are required to enable operation of FX Supervisory Controllers, FX Server, and FX
Tools Supervisor Pro. License files are keyed to the host ID. A host ID is unique to each hardware
platform.

+ Host IDs that begin with Win- are targeted to computers.

* Host IDs that begin with Qnx- are targeted to FX Supervisory Controller.
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A license file is a text file (FacExp. 1icense) that you can read but not edit. License files contain a
digital signature, and any attempt to edit them renders the files invalid.

Included in each license file is a list of features allowed to operate inside the host device. These
features may include network drivers, database drivers, the maximum number of devices allowed,
the maximum number of points allowed, tool profiles, and other feature options.

Also included in each license file is the version of Niagara software allowed to operate inside the
host device. When upgrading software in a host (computer or FX Supervisory Controller), the
license version must be equal to or greater than the software version.

Niagara™ is to be discontinued so ensure that you update your software to the latest version. Refer
to Discontinuation of Facility Explorer supervisory hardware models FX30, FX60, and FX70 and Facility
Explorer 6.x software (LIT-12001208) for further information.

Also, if you are emailed the licenses, the Niagara 4 .zip file also contains the Johnson.license for N2.

Part Numbers

The FX80 requires three parts: the base (which comes with SD card), the device license, and the
maintenance license. Refer to the FX80 Supervisory Controller Catalog Page (LIT-1901010) for further
details. Refer to the FX80 Supervisory Controller Control Panel Assembly Catalog Page (LIT-1901017) for
details on ordering a Control Panel with an FX80 Controller.

Table 7: Suggested replacement FX30, FX60, and FX70 ordering information

Discontinued FX Supervisor order code Suggested replacement FX Supervisor order

code
LP-FX3011E-1 FXSC8BASE-0 (Wi-Fi embedded - North America
LP-FX3021E-1 only)
LP-FX6011E-1 FX-SC8BDWIFI-0 (Wi-Fi disabled)
LP-FX6021E-1
LP-FX7011N-1 FX-SC8CL###-0 (Core device license)

FX-SC8DL##-0 (Additional device license)
LP-FX7021N-1

FX-SC8D###M#-0 (Maintenance license)

LP-FX30BDEM-1 FX-SC8BASE-0
LP-FX60BDEM-2 FX-SC8CLDEMO-0
LP-FX6011E-1G None

Refer to Discontinuation of Facility Explorer supervisory hardware models FX30, FX60, and FX70 and
Facility Explorer 6.x software (LIT-12001208) for further information on migrating 6.x licenses to a
corresponding or similar 14.x release.

Detailed Procedures for Upgrading FX Workbench
6.x and Earlier

® Note: If you are using Facility Explorer 5.x or earlier and want to migrate to Facility Explorer
14, you must purchase the upgrade part to move to Facility Explorer 6.x before you move
to Facility Explorer 14.x. To migrate to Facility Explorer 14.x, see Detailed Procedures for
Migrating to FX Supervisory Software 14.x.
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This section describes how to back up your FX Supervisory Controller and prepare it gor upgrading.
It also provides detailed instructions on how to upgrade FX Workbench, re-license the FX
Supervisory Controller, and install new software into the FX Supervisory Controller.

Backing Up Your FX Supervisory Controller Station

Expand the Nav tree for the station you want to back up.

In the Nav tree, expand Platform.

Double-click Station Copier.

Select the station that you want to copy from the Stations on panel.

Click Copy.

Enter a name for the Station name and click Next.

Select Copy every file in the station directory and its subdirectories and click Next.

Nouvuhwbh =

Table 8: Transferring Station Copy Options

Feature Description

Allows you to select individual files to copy
and transfer

Copy files from selected directories

Copies all files for transfer (recommended
for backing up a remote station during this
upgrade procedure)

Copy every file in the station directory and its
subdirectories

Copies the station database only (for
Copy only the config.bog station database file example, drivers, devices, and points) and no
associated files

8. Click Next. The station is stopped.

9. Verify that the transfer information is correct and click Finish. The station files are transferred
to your computer. When the transfer is complete, the Save station and Transfer files
indicators turn green, and the last entry in the Transferring station window states Transfer
complete

10. Click Close. The remote station is now backed up to your computer.

Preparing Your FX Supervisory Controller for Upgrading
Upgrading FX Supervisory Controllers typically requires additional memory.
® Note:

* You must make sure your FX Supervisory Controller has an adequate amount of memory
before you attempt the upgrade. If you attempt to upgrade an FX Supervisory Controller
that does not have enough memory, the upgrade procedure fails and your FX Supervisory
Controller may become unrecoverable.

« Do not attempt to upgrade an FX40 (with standard memory, 128 MB RAM, 31 MB flash) to
version 2.2 or higher. The FX40 does not have enough memory to support this upgrade.

« Do not attempt to upgrade an FX20 to Release 5.0 if the /ffs0 partition is less than 5.0 MB
of file space. To see how much free file space is available, open the Platform\Platform
Administration view and note how much file space is free. If there is less than 5.0 MB
free, we do not recommend that you upgrade to FX20 (1024 KB = 1 MB. 5120 KB = 5 MB).

FX Supervisory Controller Upgrade and Migration Instructions Technical Bulletin 1



Checking for Minimum Memory Requirements

Start FX Workbench on your PC.

2. Connect to the FX Supervisory Controller by selecting File > Open Remote Station and
entering the IP address and platform and station login credentials.

3. Inthe Navigation sidebar, expand Administration, double-click Platform, and verify the file
system (/ffs0) has the minimum memory requirements identified in Table 9. If it does not, see
before continuing with this upgrade.

Table 9: Approximate Memory Requirements for Upgrading

Feature Description

From 1.2to 2.0 3072 KB (3.0 MB)

From 1.2 to 3.0 Not recommended

From 2.0 or 2.1 to 3.0 10,000 KB (10 MB)

From 2.2t0 3.0 5,000 KB (5 MB)

From 3.0 to 4.1 5,000 KB (5 MB)

From 4.1 to 5.0 5,000 KB (5 MB)

4. If your FX Supervisory Controller does not contain the minimum memory requirements, then

delete unused files to increase the file space. Some files that are likely unused are the Graphic
Templates stored in the sysGraphicsFile, sysGraphicsFileHx, sysPxFile, and sysPxFileHx
folders.

® Note: If you delete all the unused files and the minimum required free space is still not
available, the FX Supervisory Controller cannot be upgraded.

Upgrading the FX Workbench Software
About this task:

You u

se FX Workbench to upgrade the FX Supervisory Controller. Therefore, you must upgrade your

FX Workbench software before you can upgrade your FX Supervisory Controller.

Table 10: Email address for license request
Base Base+E
software.manufacturing@jci.com SW.Authorize@jci.com

1.

Email a request for an upgraded license to your FX Workbench. Use Table 10 to determine the

correct email address for your region. In your email, please provide your host ID (Win-####).

® Note: If your FX Workbench software is not currently part of a software maintenance
agreement, you need to order a software upgrade. Include your purchase order number
on the same email.

2. Receive the upgraded FX Workbench software license, unzip it, and paste it into the licenses
folder ( FxWorkbench-14.x\security\licenses).
3. Obtain the most recent version of FX Workbench by downloading it from the Pro FX User
Connected Community on http://hvacnavigator.com.
® Note: The license file you obtained in Step 2 should be automatically copied from your
previous installation directory and pasted into the licenses folder of your new installation
directory. If not, copy and paste it there.
4. Navigate to the downloaded license folder (Start > Programs > FX Workbench 14.x >
FX Workbench 14.x Pro)and then right-click on the Installer.exe file.
5. Click Run as adminstrator to install the software.
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Relicensing the FX Supervisory Controller

About this task:
If your FX Supervisory Controller is not currently part of a software maintenance agreement, you
must order a software upgrade license.

1. Email a request for an upgraded license. Use Table 10 to determine the correct email address
for your region. Provide your host ID (Qnx-####) and purchase order number (if buying a
software upgrade license).

2. Receive the upgraded FX Supervisory Controller license and paste it into the licenses folder of
your FX Tools Supervisor Pro installation directory (C: \JCI\FxWorkbench-x.x\security
\licenses).

3. Start FX Workbench by clicking Start > Programs > FX Workbench 14.x > FX Workbench 14.x
Pro.

4. Connect to the FX Supervisory Controller by selecting File > Open Remote Station and
entering the IP address and platform and station login credentials.

5. Expose the Nav tree.

6. Inthe Nav tree, double-click Platform.

7. Double-click License Manager.

8. Click Import.

9. Click Import one or more licenses from files.

10. Click OK.

11. Select the location of the new FX Supervisory Controller license file you received in Step 2.

® Note: Select the license with Qnx- in the Host ID number.

12. Click OK.
13. Click Yes on the Licensing Complete dialog box to reboot the system.

® Note: The reboot process can take up to 5 minutes depending on network and
computer performance. There is no indicator for the progress of the reboot. If an
attempt to reconnect to the FX Supervisory Controller fails, wait for the system to
complete the reboot and try again.

14. Reconnect to the FX Supervisory Controller after the reboot process has completed.

Installing New Software into the FX Supervisory Controller

1. Start the latest release of FX Workbench by clicking Start > Programs > FX Workbench 14.x >
FX Workbench 14.x Pro.

2. Connect to the FX Supervisory Controller by selecting File > Open Remote Station and
entering IP address and platform and station login credentials.

Expand Platform.
Double-click Platform Administration and then click Commissioning.
Leave the default selections and click Next.

Verify that the license revision installed on the FX Supervisory Controller allows you to install

the latest software.

7. Click Install one or more licenses from files if the FX Supervisor requires an upgraded
license. Click Don't change any licenses if the installed license supports the FX Supervisory
Software revision being added.

8. Click Next.

9. Click UI+RUNTIME and click Next.

o v kW
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10. In the Station list, select Don't transfer a station and click Next.
Figure 1: Commissioning Wizard - Software Installation
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Figure 2: Commissioning Wizard - Software Installation
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11. Click Upgrade All Out of Date. The system selects the check boxes next to the out-of-date
software. Use the scroll bar to locate and add additional .jar files that were added with the
new release but may not have been on the FX Supervisory Controller that is being upgraded.

In the Avail. Version column, look for .jar files from Johnson Controls. Select the

check box to include a .jar file in the upgrade process. For example, if you select the
jciAutoImport .jar file, then the file is included with the upgrade.

You do not need to add .jar files like yciLX, jciLXDevices, Or jciLXMain unless you
have a LonWorks® network.

12. Click Next. The Distribution File Installer lists the software that needs to be installed.
13. Click Next.
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14. Leave the default selections and click Next.
15. Keep the current Platform name and password and click Next.
16. Click Finish. The station stops running. All .jar files are now updated.

Upgrading FX Server

1. If your FX Server is not currently part of a software maintenance agreement, you must
order a software upgrade license. Email a request for an upgraded license. Use Table 10 to
determine the correct email address for your region. Provide your host ID (Win-####) and
purchase order number (if buying a software upgrade license).

2. When you receive the upgraded FX Server license, paste it into the licenses folder of your FX
Server installation directory (C: \JCI\FxServer-x.x\licenses).

3. To obtain the most recent version of FX Server, download it from the Pro FX User Connected
Community on http://hvacnavigator.com.

4. Install the new FX Server software.

® Note: The license file you obtained in Step 1 should be automatically copied from your
previous installation directory and pasted into the licenses folder of your new installation
directory. If it is not, copy and paste it there.

5. Copy your station files from the old FX Server installation directory (C: \JCI\FxServer-x.x
\stations\station name)to the new FX Server installation directory.

6. Run the software by clicking Start > Programs > FX Server.

Detailed Procedures for Migrating to FX
Supervisory Software 14.x

Migration is similar to upgrading, but signifies a larger change in software. Migration typically
requires more steps and conversions to move forward.

In the Appendix of this document, a high-level migration checklist has been provided to assist with
your decision on migration. See the Migration Checklist.

Prerequisites for Migration

If you are not at FX Supervisory Software 6.x, you must upgrade to FX Supervisory Software 6.x
before you migrate to FX Supervisory Software 14.x.

Before migrating an FX Supervisory controller, you need to have the following:

+ astation running FX Supervisory Software 6.x. To upgrade FX Supervisory Software 6.x, see
Detailed Procedures for Upgrading FX Workbench 6.x and Earlier.

+ alicensed version of FX Supervisory Software 14.x on your computer
* new FX Supervisory Software 14.x licenses for the controller that you are migrating

FX Supervisory Software 14 Migration Considerations

Many factors should weigh into the decision on whether or not to migrate an FX Supervisory
Controller and FX Server. This section provides guidelines for migration of your application.
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Considering Platform Compatibility

Determine if the desired platform is compatible with FX Release 14.9 and later. Use the following

table as a reference.

The information in the following table does not guarantee that you can migrate the station on that
platform; instead, the table explains which platforms are not able to migrate.

Table 11: Platform Compatibility

Compatible with FX Release 14.9

Not Compatible with FX

Windows Server 2012

AT and later Release 14.9 and later
FX Supervisory « FX80 FX20, FX30, FX40, FX60, and FX70
Controllers
Windows® Vista®
Windows 8.1 Windows XP
FX Server Windows 10.0 Windows Server 2008

Windows 7

Linux®

Options for dealing with incompatible platforms include:

+ Keep incompatible platform at FX Workbench Release 6.x. These platforms can interact with
platforms at FX Release 14.x with some limitations. The FX Server must be at FX 14.%, if any
other supervisory controller on the network is at FX 14.x. For example, to install or upgrade any
supervisory controller to FX 14.x, you must update the FX Server to 14.x. The FX Server must be
at the highest release, or greater, of any FX80 on the network.

+ Replace the platform with a compatible platform.

Table 12: FX Supervisory Controller Network Compatibility

6.x (Platform)

From To Supported Notes
FX Supervisory .
Controller 14 gis(gfaig:)ory Controller Yes Limited
(Station) )
FX Supervisory .
Controller 4.x to 6.x FX Superwsory Controller Yes With exceptions

. 14 (Station)
(Station)
FX Supervisory
Controller 14 FX Server 6.x No Not blocked
(Station)

Connection is available for

EX Workbench 14 FX Supervisory Controller Yes migration process to FX

Supervisory Software Release
14

16
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Table 12: FX Supervisory Controller Network Compatibility

From To Supported Notes

FX Workbench 14 FX Superwsory Controller No Blocked
6.x (Station)

FX Workbench 6.x FX Supgrwsory Controller No Blocked
14 (Station)

FX Workbench 6.x FX Supervisory Controller No Blocked
14 (Platform)

For more detailed information on compatibility, in FX Workbench 14 Pro from the Help menu, select
Help Contents. Click the Search tab and type compatibility.

Considering Driver, Feature, and Application Compatibility

You must also consider driver, feature, and application compatibility. Facility Explorer Release 14
is a significant code base change. For modules that worked at Facility Explorer Release 6.x and
earlier to work at Facility Explorer 14 and later, they must be refactored. All modules developed by
Johnson Controls have been refactored for use in Facility Explorer Release 14 with the exception of
the Wireless TEC module.

Table 13: Johnson Controls Modules

Johnson Controls Module Refactored FX Release 14.x
jciAutoImport.jar Yes
jciBacnetParser.jar Yes
jciBACnetTEC.jar Yes
jciCoreParser.jar Yes
jciDictionary.jar Yes
jciFxDriver.jar Yes
jciFxDriverAppliance.jar Yes
jciFxDriverHx.jar Yes
jciMeters.jar Yes
jcin2.jar Yes
jciN2Parser.jar Yes
JCiIN2TEC jar Yes
jciSpaces.jar Yes
jciSupport.jar Yes
jciTools.jar Yes
kitPxHvacSmall.jar Yes
wirelessStat.jar No

® Note: The Wireless TEC module is loaded by factory default on all of the FX Supervisory
Controllers. The FX14UpgradeAssessmentTool does alert you that this module has not been
refactored for use for Facility Explorer Release 14. If the Wireless TEC is not being used, you
may choose to ignore this alert. We recommend, however, that you remove this module if it
is not in use. If the TEC module is being used, then the FX Supervisory Controller should not
be migrated to Facility Explorer Release 14. This module is for the older generation Wireless
TEC2000 models, and is not compatible with the FX80.
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® Note: The TEC3100 wireless needs a WRG coordinator for usage.

For Niagara driver and application support, refer to the Niagara 4 Driver and Application Support
Section within the Niagara Help system to determine which drivers have been refactored for
Niagara 4 and FX Supervisory Software Release 14.

If the platform, drivers, features, and applications have been determined to be compatible and/or
supported for use with FX Supervisory Software Release 14, do the following:

1. If the platform is at a release less than FX Supervisory Software Release 6.x, you must purchase
and upgrade that platform to FX Supervisory Software Release 14.x and ensure it is running
properly before moving further.

2. On supported FX Supervisory Controller platforms, run the FX 14 Upgrade Assessment Tool
to determine if the required resources are available. See FX Supervisory Software 14 Resource
Requirements.

3. Iftheresource requirements are met, purchase the software maintenance parts for the
appropriate platform. Software maintenance may be purchased in 1, 3, or 5-year increments.
For more information on software maintenance parts, refer to the FX Supervisory Controller
Product Bulletin (LIT-12012250).

4. Follow the instructions on migrating your platform and station.

Considering License Compatibility

Licensing has been changed for FX Supervisory Software 14 and later. Licensing is moving from a
driver and integration model (FX Supervisory Software 6.x and earlier) to a field controller capacity
model (FX Supervisory Software 14.x and later).

FX Workbench, FX Servers, and FX Supervisory Controllers require the appropriate license to match
the Facility Explorer Release that it is running. For example, an FX Supervisory Controller running at
Release 6.1 requires the Niagara AX license.

Figure 3: FacExp.license in FX Workbench 6.1

point. limit= mit = device.limit="1§"/>
™ achedule.limit="none” foreignPoint.limit="none" export="true” point.limit="none" hiat

=5
= ui.wb="true” ui.wb.admin="crue®/>
APQLi0Z28F1hBoHdNENSe Y=</ aiqnature:

<signature>MCOCEFCOML
</1icense>

In Figure 3, notice the FacExp.license (Niagara AX) in FX Workbench 6.1. The version is 3.8 and that
the jciN2 license is part of the FacExp.license file.

An FX Supervisory Controller running at Release 14.x requires not only a Niagara 4 license, but also
a Johnson Controls license (this is for the N2 protocol which was separated from the overall Niagara
AX license).
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Figure 4: License in FX Workbench 14.x
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In Figure 4, notice the FacExp.license (Niagara 4) in FX Workbench 14.x. Its version is 4.0 and no
jciN2 license is included.

Figure 5: Johnson.license
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</license>

Figure 5 displays the Johnson.license (Niagara 4) in FX Workbench 14.x. This license is required
when using the N2 protocol.

In general, a licensing model stays with a product throughout its lifetime. Parts purchased with an
LP- prefix follows the FX Supervisory Software 6.x and earlier license models. Parts purchased with
an FX- prefix follows the FX Supervisory Software 14.x and later 4.x license models.

The only exception to this rule is that to migrate a platform from FX Supervisory Software 6.x to FX
Supervisory Software 14.x, you must purchase and apply an FX- software maintenance part to an
LP- platform.

® Note: Products with LP- prefix do not ship with Facility Explorer Release 14.x and later. These
products must be migrated in the field to use FX Supervisory Software 14.

Example of an FX Supervisory Controller Migration

Using the following flowchart as an example of when to migrate to FX Workbench 14.x.
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Figure 6: Migrating an FX60 Supervisory Controller
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FX Supervisory Software 14 Resource Requirements

About this task:
Facility Explorer 14 requires more disk space, Java® heap, and RAM to run than a similar Facility

Explorer 6.x station. Therefore, a controller with Facility Explorer 6.x running near capacity may not
fit the same-sized station when migrated to FX Supervisory Software 14. The reasons are as follows:

+ Disk space (flash)-FX Supervisory Software 14 requires between 14 to 16 MB more space
than an equivalent FX Supervisory Software 6.x installation. Additional space is required by
the new Java 8 Virtual Machine (VM) and new HTML5 UX features that enable a rich browser
experience.

+ Heap space-For an equivalent station, more Java heap is required due to new features and
functionality. The baseline heap increase is about 10 MB. Additionally, more system memory is
required.
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* History RAM disk size (FX60 and FX60E only)-The maximum history RAM disk size on an
FX60 has been reduced from 64 MB to 32 MB to free additional system memory. The default
RAM disk size is 32 MB, so this should not affect most units. If the RAM disk on an FX60 with FX
Supervisory Software 6.x has been upgraded, then this increase in the RAM disk size comes at
the expense of heap space (for example, if you upgrade your memory, the additional 32 MB is
allotted for heap space and is not usable as RAM post-migration).

® Note: Maximum history count has not changed.
Run the FX14UpgradeAssessmentTool on the Release 6.x Supervisory Controller to determine if it

meets the minimum requirements to be migrated to FX 14. The FX14UpgradeAssessmentTool is a
program that is included with the FX Workbench 14 installation. The program checks your controller
for memory and heap resources, disk space, .jar files, and for password encryption.

® Note: For the migration, the Facility Explorer Upgrade Assessment Tool automatically
modifies the Backup Service to include the history and alarm data in the backup process
(which comes later in the process). However, because of possible size limitations, the four
graphics folders (sysGraphics file, sysGraphicsFileHx, sysPxFile, and sysPxFileHx) are removed
from the backup process. Although space is gained by the removal of these graphic files,
you no longer have access to these files after the migration. These files may be added post-
migration as space allows.

» Important: After the FX14UpgradeAssessmentTool has completed, you must delete it from
the station; otherwise, it may cause the migration tool to fail.

® Note: Before you perform this procedure, you must first install FX Workbench 14.
Default Values for the Backup Service Exclude Files and Directories

The following default values for the Backup exclude files and directories of the Backup Service.
If needed, you can change these settings after a station migration, so that the backup of the
station has the original settings.

Table 14: Default Values for the Backup Service Exclude Files and Directories

Field Description
*.hdb;*.adb;*.lock;*backup*;console.*;config.bog.b*;conf
ig_backup*

file:AMhistory

Exclude Files

Exclude Directories
file:ANalarm

Offline Exclude Files *.lock;*backup*;console.*;config.bog.b*;config_backup*

Checking for FX Supervisory Software 14 Resource Requirements

About this task:
To check for FX Supervisory Software 14 Resource Requirements:

1. Start FX Workbench 6.x by clicking Start > Programs > FX Workbench 6.x > FX Workbench Pro
6.x.

2. Inthe Nav tree, expand:

My Host > My File System > C > JCI > FXWorkbench-14.x > jciStandards > to view the
FX14UpgradeAssessmentToolV1_9.bog
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Figure 7: Copy Bog File
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3. Right-click the FX14UpgradeAssessmentTool program object, and select Copy.
4. Inthe Nav tree, connect to and expand the station you want to migrate.

» Important: You must run the assessment tool on the FX Supervisory controller station.
The tool cannot check the appropriate resources when the station is moved to run from

a computer.
5. Under Config > Services, right-click ProgramService and select Paste.

6. If you want to change the FX14UpgradeAssessmentTool program object name,
enter the new name and click OK. Otherwise, leave the name as is and click OK. The
FX14UpgradeAssessmentTool now appears under ProgramService.

Figure 8: Change Tool Name
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Figure 9: Paste File
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7. Expand ProgramService and right-click FX14UpgradeAssessmentTool and select Actions >

Check Upgrade Status.

The tool generates a dialog box that displays requirement information and indicates if
the device meets the minimum requirements for migration to FX Workbench 14.
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Figure 10: Facility Explorer Upgrade Assessment

=

<2 FX14 Upgrade Assessment Tool v1.9

@ FX14 Upgrade Assessment Tool v1.9
*** Note: This program cannot predict performance of N4 on same hardware. ***

This station Updated the Backup Service to include History and Alarm data in the Backup process.
...and Updated the Backup Service to EXCLUDE directories: sysGraphicsFile, sysGraphicsFileHx sysPxFile and sysPxFileHx.

This station meets the estimated Java heap and disk space requirements for N4 on the same JACE platform type.

Free Disk Space Test PASSED
- Free disk space of 61.08mb meets min of 24mb

Free Heap Memory Test. PASSED
- Max heap feature notlicensed

Ram Disk Size Test PASSED
- Required RAM disk size 32mb does not exceed default of 32mb
- Mo Additional RAM disk required

Additional tests:

Third Party Module Test Warning
- 13 third party modules detected on platform. These modules must be refactored for N4,
Niagara AX types without an N4 module will be removed by the migration tool.

OK! jciBacnetParser - Johnson Controls
OK! jciCoreParser - Johnson Controls
OK! jciDictionary - Johnson Controls, Inc.
OK! jciFxDriver - Johnson Controls
OK! jciFxDriverAppliance - Johnson Controls
OK! jciFxDriverHx - Johnson Controls
OK! jciLonParser - Johnson Controls
OKI jciN2Parser - Johnson Controls
OK! jciSupport - Johnson Controls
OK! jciTools - Johnson Controls
OK! jcin2 - Johnson Controls
OK! kitPxHvacSmall - Johnson Controls

NEEDS Update! wirelessStat -

Client Password Test: PASSED
- No client passwords need editing before migration.

The FX14UpgradeAssessmentTool also indicates if it finds third-party modules
(modules that are not Tridium modules). All Johnson Controls modules work with FX
Workbench 14.x with the exception of the wirelessStat.jar.

» Important: The NEEDS Update! WirelessStat message always appears. The
WirelessStat.jar file is included with every FX Workbench installation, but does not
work with FX Workbench 14.x. If you are using the wirelessStat driver for wireless TEC
controllers, you are not able to migrate to FX Workbench 14.x.
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» Important: The Client Password Test is a test to see whether user passwords can be
decrypted by the tool. If the test fails, you must go back to the FX Workbench 6.x version
of the station and re-enter the credentials, backup, and start again.

8. Click OK.
9. To view additional information, double-click the FX 14 Assessment Tool.
Figure 11: Upgrade Compatibility Tool Property Sheet
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10. Inthe Nav tree, right-click FX14UpgradeAssessmentTool and click Delete.

® Note: To view a .txt file of the upgrade status, double-click Files from the Nav Tree for
the station. Double-click CompatibilityToolLog.txt. A .txt file appears displaying a text
version of the status generated by the compatibility tool.

» Important: After using the FX14UpgradeAssessmentTool, you must delete it from the
station; otherwise, the tool may cause the migration tool to fail.

Checking for Multiple Admin Roles

About this task:

To migrate a station, you must not have more than one user with the name Admin. If you have
more than one user with the name admin, you must delete the extra users. If more than one user
exists with the same Admin name, the migration fails.

1. Inthe Nav tree, expand Station > Config > Services.
2. Double-click User Service. The User Manager appears.
3. Inthe view selection on the top-right side of the screen, select AX Slot Sheet.
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4. Review the names in the Name column. In the example above, notice that slot number 9
contains admin and slot number 14 contains ADMIN. Only one admin name is allowed (even
if capitalization is different). The user roles have the baja:User type.

5. If you have more than one user with the name Admin, right-click the duplicate name (with
the baja:User type), and select Delete.

Backing Up Your FX Workbench 6.x Station

About this task:
For the migration to FX Supervisory Software 14, back up the station using FX Workbench 6.x. You

cannot backup a 6.x FX Supervisory Controller from FX Workbench 14.

® Note: Make sure to move the station from the FX Supervisory Controller to the Local Host via
the Station Copier after you back up the station. Doing this guarantees that there is space on
the FX Supervisory Controller when you install FX Workbench 14.

1. In FXWorkbench 6.x, connect to the station you want to back up.
2. Right-click the station you want and select Backup Station. A screen appears prompting you
to save the backup .dist file to a location.

Figure 12: Station Backup

File Chooser \E\
Q File Spaces o
== My File System | backups
dDBAC | B=|e-F[3
,D_, Bookmarks =
E] PRN PARSER DEMO

File name: |bac.k11p SunriseClinick Migrate.dist

|
Fies of type: |Distribution File [+]

3. If necessary, enter a different name of the backup in the File name field.
4. Click Save. You can view the backup in the BackService, which is located in Station >
Administration > BackupService.

® Note: You can also back up your station by going to Station > Services> BackupService,
selecting the desired .dist file, and clicking Backup.
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Running Platform Daemon 14.x

When opening the Platform Daemon 14.x, you are indicating the version of FX Workbench you want
to run.

® Note:

+ Certain antivirus programs may attempt to block you from running the Platform Daemon
software.

+ Before running the platform daemon, be sure to close out any instances of FX Workbench
software.

Click Start > FX Workbench 14.x > Install Platform Daemon 14.x. You can now start FX Workbench
14.

Migrating the 6.x Station to Facility Explorer 14.x

About this task:

During the station migration, we recommend that you have a serial shell open to help you monitor
the migration. Having the serial shell open helps you monitor the items being loaded on the FX
Supervisory Controller, track errors, and view when the migration is finished. For more information
about the serial shell, see the About JACE Serial Shell Mode section of the Niagara Help.

« By default, files in the SysPxFile, SysPxFileHx, SysGraphicsFile, or the SysGraphicsFile folders
are not migrated to the converted station.

« If you are migrating a station that uses older graphics with a tab pane, you need to clean the
graphics up to remove the tabs.

1. Start FX Workbench 14.

2. On the Tools menu, click Migrate Station.

3. Inthe Backup DIST Name (Ver 3.8) field, click the folder button and select the .dist file from
the FX Workbench 6.x backup directory. For example, c: \JCI/FXWlorkbench-6.2/backups/
backup SunriseClinic 151121 0914.dist.After selecting the .dist file, click Open.

4. Do one of the following:

- If you are migrating an FX Supervisory Controller station, click Migrate JACE Station.
- If you are migrating in FX Server, click Migrate FX Server Station.

5. Click Migrate Station. The migration tool begins the migration process. The migration
background screen appears. Use this screen to monitor the progress of the migration. This
process can take several minutes.

As the migration is running, the system creates a log file whose name is a the
combination of backup .dist file name (backup SunriseClinicA Migrate.dist)
plus _miglog_ plus the date/time code 151007_1539 plus .html.

For example:

backup_ SunriseClinicA Migrate.dist miglog 151007 1539.html.

Locate the log file in the Nav tree under My File System > User Home > stations.

® Note: Before the migration process finishes, a lock file is created that uses the log file
name plus .Ick file name extension. Once the migration finishes, this .Ick file is delete.
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6. The Migration screen displays that the migration is completed. When prompted by the
migration background screen, press any key to continue. Windows Explorer appears and is
opened to the directory where the migration .log file was placed.

7. Click Close. The station has now been migrated and is ready to be loaded on the FX
Supervisory Controller.

Installing the Distribution File
About this task:

1. On the File menu, select Open > Open Platform. The Connect screen appears.
Figure 13: Connect

[ & Connect ﬁ ]

Open Platform
Connect to the host's platform daemon

Session

Type |7 Platform Connection

Host IP Super <
Port 3011
OK Cancel

2. Inthe Type field, select the session type.
» Important: The Type field defaults to Platform TLS Connection, which may not be
enabled on the controller. Select Platform Connection if TLS is not enabled.
3. Enter the IP address of the device to migrate and click OK.

4. Log into the Platform for the device you want to migrate. These credentials are the same
credentials used to log into the platform of the FX Supervisory Controller at Release 6.1.

5. Inthe Nav tree, double-click Platform > Platform Administrator. The Platform Administrator
screen appears. Confirm that the Baja Version Niagara 3.8.x.

® Note:

- If the Baja version is less than 3.8.x, then you must first upgrade to FX Workbench
6.x. See Detailed Procedures for Upgrading FX Workbench 6.x and Earlier.

- A warning message may appear on the screen indicating the default platform
credentials. The migration process requires you to change the default platform
credentials to a different user name and strong password.

6. Inthe Nav Tree, expand Platform and double-click Distribution File Installer. The
Distribution File Installer screen appears.

7. On the bottom of the screen, click Conversion. Conversion files that are not appropriate for
use on the current FX Supervisory Controller are disabled.

8. Select the bold (non-disabled) .dist file and click Install. A message appears indicating that
running applications need to be stopped before the installation can proceed.
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Figure 14: Stopping Applications

@ Distribution File Installer @
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9. Click Finish. FX Workbench 14 installs the base Niagara 4 image on the controller. The status
of the installation appears on the Installing Distribution screen. The installation may take
several minutes.

10. When the installation is complete, click Close. The controller reboots. The reboot may take
several minutes.

11. Log back into the platform and open the Platform Administrator. Confirm that the device
Daemon Version now says 4.0.xx.xx and the Baja version is blank. The installation of the
conversion distribution file may revert the platform credentials back to the default values.

Commissioning the Station

About this task:
After migrating the station to FX Supervisory Software 14, you need to commission the station.

1. Inthe Nav tree, expand Platform.
2. Double-click Platform Administrator.
3. Click Commissioning.
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Figure 15: Commissioning Wizard
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= Commissioning for ﬁ

\ Commissioning

This wizard combines stepsforconfiguring a host to run stations. Please check below foreach type of configuration
change you wish to make:

[#] Requestorinstall software licenses

[#] setenabled runtime profiles

[#] Install a station from the local computer

[ Install lexicons to support additional languages
Install/upgrade modules

[# In=talliupgrade care software from distribution files
Syncwith my local system date and time

[ Configure TCP/IP network settings

[#] Configure system passphrase

[ configure additional platform daemaon users

ClearAll | Checkall

o Finish ¥ cancel

4. Select the check boxes based on the following table. Make sure the Configure additional
platform daemon users is checked.

Table 15: Commissioning

Field Description

Preselected and disabled for any new FX
Supervisory controller

Preselected and disabled for any new FX
Supervisory controller

Request or install software licenses

Set enabled runtime profiles

Ensure that this field is selected as you will be
Install a station from the local computer installing the new migrated station from a local
computer.

Option to install file-based lexicon sets
(alternative to lexicon modules). Typically you
leave this field unselected. Lexicon modules are
recommended in FX 14.

Install lexicons to support additional languages
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Table 15: Commissioning

Field

Description

Install/upgrade modules

Always preselected when the wizard is run.
Selects the software modules and optionally any
lexicon modules.

Install/upgrade core software from distribution
files

Preselected and enabled for any new FX
Supervisory controller

Sync with my local system date and time

Preselected in most cases. For new controllers
(for example) where the controller time may
greatly differ from actual time.

® Note: Ensure that this field is selected to
update the date and time from the defaults
placed in the controller with the conversion
AXtoN4 distribution file.

Configure TCP/IP network settings

Recommended

Configure system passphrase

Preselected and enabled for any new FX
Supervisory controller

Remove platform default user account

Preselected and enabled for any new FX
Supervisory controller. You cannot commission
a unit with the factory-default platform admin
user.

Configure additional platform daemon users

Recommended option if you require additional
platform admin user accounts with unique user
names and passwords (all additional accounts
have full and equal privileges).

5. Click Next. The Station Installation screen appears.

Installing or Updating Licenses
About this task:

Click OK.
Click Next.

Hwbnh -

Setting the Enabled Runtime Profiles
About this task:

Select Install one or more licenses from files if you have the FX Workbench 14 license file.
Click Add and select the required licenses. The licenses appear on the right side of the screen.

Enabled runtime profiles specify what types of FX Supervisory Software 14 software module .jar files

to install.
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Figure 16: Enabled Runtime Profiles
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1. Use the following table as a reference. Make sure to select both the UX and WB check boxes.

Table 16: Enable Runtime Profiles

Field

Description

RUNTIME: Module JARS having core runtime
Java classes only, no user interface.

Read-only. Always selected.

UX: Modules JARs having lightweight
HTML5+Javascript+CSS user interface only.

Select to support web client browser access,
using HTMLS5, Javascript®, and CSS technologies.
The client does not need to run Java and
download WbApplet from the controller. When
you select this field, the WB field is also selected.

® Note: Certain views at FX Release 14 have
not been converted to HTML5. These views
include the Device Manager, Wire Sheet,
and Px Editor views. They are scheduled to

be converted at a future release.

WB: Modules JARs having Workbench or
Workbench Applet user interface classes.

Auto-selected when you select UX. Select WB
if the supervisory controller must also support
browser Web Workbench access from Java-
enabled clients, using the WbApplet.

SE: Modules JARs having Java classes that use
the full Java 8 Standard Edition (SE) platform
API.

Not available for QNX-based FX Supervisory
Controllers.

DOC: Modules JARs having no module classes.

Selectable, but not recommended for file space
reasons on an FX Supervisory Controller.

2. Click Next. The Station Installation screen appears.
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Specifying a Station to Install

About this task:

To commission the station, you must first specify the station to install.
Figure 17: Station Installation
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The passohrase that's used to protect the locsl copy of the station is not the same a3 the remote host's system passphrase. Pletase
enter the local copy’'s pasaphrase.

File Passphrase

[#] STARTAFTER INSTALL: Start the station immediately after it is copied

[# AUTO-START: Start the station every time the platform daemon starts

4 Back | p Next | ' Finish ¥ cancel

In the Station box, select the name of the station database on your computer.
If desired, enter a new station name. Otherwise, do not change it.
Enter the system passphrase.

If desired, select one or both of the following check boxes (we recommend that you select
both check boxes):

Awbn -

- START AFTER INSTALL: Start the station immediately after it is copied.

- When you select this check box, the station is restarted at the end of
commissioning, even if you do not reboot the FX Supervisory Controller.

- AUTO-START: Start the station every time the platform daemon starts.

- When you select this check box, the station starts every time the FX Supervisory
Controller is rebooted.

5. Click Next. A dialog box appears asking which station files to copy.
6. Select one of the following:

- Copy files from selected directories (recommended)

- Allows you to specify which subfolders under that local station that are copied. This
action produces a tree selection after you click Next.

- Copy only the config.bog station database file

Copies only the station configuration (components), and not any supporting folders
and files (for example, PX files and HTML files).
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7. Click Next. A screen appears asking you to select subfolders.

8. Select the subfolder under the local station to copy. Expand the folders as needed. By default,
the directories are selected to be copied to the station. Directories that are not selected are
no longer required. Typically, you leave all directories selected.

9. Click Next. A dialog box appears asking you to select the software to install.

10. Select the software to install.

11. Click Next.

Installing Core Distribution Files

About this task:
During commissioning, the dependencies of the FX Supervisory Controller platform are compared

against the distribution (. dist) files available in your FX Workbench computer's software
database. The wizard determines what .dist files need to be selected for installation. The
software you need to install is displayed on the screen.

Click Next to select the distribution files. A TCP/IP configuration screen appears.

Configuring TCP/IP Settings

About this task:
To commission the station, you may need to update the station's TCP/IP settings.

1. Review the settings on the IPv4 Settings tab, which include the temporary factory-shipped IP
address.
2. Assign the controller a unique IPv4 address for the network you are installing it on. No other
device on this network should use this same IP address. Include the appropriate subnet mask
used by the network.
Alternatively, if the network supports DHCP, you can enable it by selecting the DHCPv4
Enabled check box. In this case, the IP Address and Subnet Mask fields become read-
only.

® Note: In general (for stability), we recommend static IP addressing over DHCP. Do not

enable DHCP unless you are certain that the network has DHCP servers.
Otherwise, the FX Supervisory Controller may become unreachable over the network.

3. If needed, adjust other TCP/IP settings, which include:

- Hostname-Use the default localhost name or enter another name you want to use for
this host.

- Hosts File-Click the arrows to expand the edit field. The format is a standard TCP/IP
hosts file, where each line associates a particular IP address with a known host name.
Use a separate line for each entry. Place the IP address in the first column, followed by
the corresponding host name. The IP address and the host name are separated by at
least one space.

- DNS Domain Name-Enter the name of network domain, or if not applicable, leave the
field blank.

- IPv4 Gateway-Enter the IP address for the device (such as a switch or a router) that
forwards packets to other networks or subnets.

- DNSv4 Servers-Click the plus sign for a field to enter the IPv4 address of one or more
DNS servers.

4, Click Next.
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Updating the System Passphrase

About this task:

All Niagara 4 platforms have a system passphrase (password), which encrypts sensitive
information. This information includes client passwords stored in .bog files and station databases
(config.bog files) or station backup distribution (.dist) files. The passphrase increases

security for the files that contain critical information. In various FX Workbench 14 operations,

you are prompted to enter the passphrase, such as when copying stations or restoring station
backups in remote platforms. The following areas in the framework are affected by passphrase
implementation:

* Provisioning

* File Transfer Client

+ Station Copier

+ Backup

+  Commissioning

+ Export Tags
The sensitive information in files is protected with encryption, either by encrypting the information
within the files or by encrypting the whole file. How the encryption is applied depends on the
portability of the file. Files located under the daemon User Home (files that belong to the system)
are encrypted using a strong, randomly generated key that exists only on that system. Files located
under an FX Workbench 14 User Home (portable files that can be sent to many systems) are
encrypted using a key derived from the user-defined system passphrase entered during software
installation or when the system passphrase changes.
Due to the different types of encryption used for the system or portable location, when
transferring files between the daemon User Home and another FX Workbench User Home, you

must use the FX Workbench platform tools (Station Copier, File Transfer, or Backup). Using the
platform tools converts files to use the correct encryption key for the target location.

» Important: Do not use Windows Explorer to copy files between the daemon User Home and
other User Homes because without the proper encryption, the files may not be readable.

For System-to-Portable Transfers

You can get portable copies of files located under the daemon User Home by any of these
methods:

* Make a backup from the Platform Administration view
+ Make a backup from a running station

+ Use either Station Copier or File Transfer Client from the Platform Administrator view

The resulting local, portable copies and backup files are protected with a passphrase.
For Portable-to-System Transfers

When you use the Distribution File Installer to restore a backup .dist file, or if you use the
Station Copier to transfer a station from your FX Workbench directory to a controller, the file's
passphrase is validated and used to translate the data back into the proper system encryption
format for use under the daemon User Home.

» Important: Remember the system passphrase and keep it safe. If you lose the system
passphrase, you lose access to encrypted data and you will need to revert to the default
system setup using the Serial Shell.
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1. Inthe Current Passphrase field, enter the default platform password. Contact your local
Johnson Controls representative for the default password.

® Note: If the default platform password has changed in the field, use the changed
password. If you have forgotten the default platform password, you can use the Serial
Shell method to reset to the default password.

2. Inthe New Passphrase field, enter a new passphrase. The passphrase must be at least
10 characters long with one uppercase character, one lowercase character, and one digit
(numeral).

3. Inthe Confirm New Passphrase field, enter the new passphrase again.
4. Click Next.

Specifying a Platform User to Replace the Factory-default Platform User

About this task:
To commission a station, you need to create a new platform account.

1. Inthe User Name field, enter a user name for platform login.
® Note: You are not allowed to use jci as a user name.

2. Inthe Password fields, type in a strong password (it must match in both password fields).
The password must use a minimum of eight characters, using at least one digit (numeral).

3. Ifyou want, enter an alphanumeric descriptor for this platform admin user in the Comment
field. The comment is seen in the Users table if there are more than one platform user.

4. Click Next.

® Note: The new platform user account is retained in the controller. For example, if you
migrate to FX Workbench 14 and then take the station back to FX Workbench 6.x, then
forward again to FX Workbench 14, you need to use the new platform credential defined
in this procedure.

5. Do the following:

- To add new users, click New User and enter the user information.
- To delete users, select the user and click Delete User.

- To change a password, click the user and click Change Password. Enter the new
password.

Reviewing the Changes

About this task:

Before you finish commissioning, review the changes and make sure the commissioning selections
have been reflected. Click Back to correct any configuration errors when commissioning the
controller.

1. Click Finish. The Completing Commissioning screen appears. This process takes several
minutes.

2. After commissioning is complete, click Close. The Facility Explorer 14 station is now copied to
the controller. The controller is rebooted and may take several minutes to complete.

Changing the Default Web Profile to Use the HTML5HXxProfile
About this task:
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Beginning at FX Workbench 14, you can take advantage of a rich web experience without the need
to install and manage a Java based plug-in. Use the following procedure to change the default web

profile to the HTML5HxProfile.
® Note:

+ The migrated station cannot render the Extensions tab of a graphic in HTML5 view.

* Certain views at FX Release 14 have not been converted to HTML5. These views include
the Device Manager, Wire Sheet, and Px Editor views. They are scheduled to be converted

at a future release.

* To add a new user which uses the HTML5HxProfile, you must first make a secure

connection to the station.

Awbn e

the following table.

Table 17: Default Web Profile

In the station, go to Config > Services > User Services.

Double-click the user. The user property sheet appears.

In the Default Web Profile section, select HMTL5HxProfile in the Type field.

In the Default Web Profile section, select the default FX Workbench display options based on

Field

Description

HX Theme

Select Zebra for a black and white color theme.
Select Lucid for a blue and gray color theme.

Enable HX Workbench Views

Select Yes to enable the HX Workbench View.
Select No to disable the HX Workbench View.

Enable Nav Tree Side Bar

Select Yes to enable the Nav Tree Side Bar.
Select No to disable the Nav Tree Side Bar.

Enable Palette Side Bar

Select Yes to enable the Palette Side Bar. Select
No to disable the Palette Side Bar.

Enable Nav File Tree

Select Yes to enable the Nav Tree. Select No to
disable the Nav Tree.

Enable Config Tree

Select Yes to enable the Config Tree. Select No
to disable the Config Tree.

Enable Files Tree

Select Yes to enable the Files Tree. Select No to
disable the Files Tree.

Enables Histories Tree

Select Yes to enable the Histories Tree. Select
No to disable the Histories Tree.

Enable Hierarchies Tree

Select Yes to enable the Hierarchies Tree. Select
No to disable the Hierarchies Tree.

5. Inthe Type Spec field, select hx and then HTML5HxProfile.

6. Click OK.

® Note: To update an existing Nav file when you upgrade to FX 14.4, click Tools and select

Update Home Page Graphic.

Viewing and Updating Metaspace

About this task:
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Use the following procedures if you receive an error in the Application Director indicating that you
are out of metaspace.

Viewing Metaspace

1. Inthe Nav Tree, right-click on the station and select Spy. A Remote Station menu appears on
the screen.

2. Click util. A util menu appears on the screen.

3. Click JMX Info. A JMX Info screen appears.

Updating Metaspace

About this task:

Use the following procedures if you receive an error in the Application Director indicating that you
are out of metaspace. The station is automatically restarted after the metaspace memory allocation
has been updated.

1. Inyour station, log into the Platform.
2. Inthe Nav tree, double-click Platform Administration. The Platform Administration screen
appears.

Figure 18: Platform Administration
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Figure 19: Metaspace Size - 30 MB
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Upgrading FX Server to FX Supervisory Software 14

About this task:

FX Server uses a similar upgrade process as supervisory controllers. However, there is no need to
use the FX14UpgradeAssessmentToolV1_9 with the FX Server to determine whether there are
enough resources to migrate.

Use the following process when you upgrade an FX Supervisory Software 14.

1. Back up the FX Server to create a . dist file. For details, see Backing Up Your FX Workbench
6.x Station. Also go to the Backup Service to ensure that the history and alarm entries are
removed (so the system does not bring the histories and alarms in the backup file).

2. Run the migration tool. For details, see Detailed Procedures for Migrating to FX Supervisory
Software 14.x. In the migration tool, be sure to:

- select the .dist file that you backed up.
- select Migrate FX Server Station.

Downgrading an FX80 from 14.x to 6.x
About this task:
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® Note: We recommend that you run a serial shell running to monitor the progress of this
installation. Having the serial shell open helps you monitor the items being loaded on the FX
Supervisory Controller, track errors, and view when the migration is finished.

1. In FXWorkbench 14, connect to an FX Supervisory Controller platform.

2. Go to the Station Copier and delete the FX Supervisory Controller 14 station.

3. Onthe Nav tree, select Platform > Distribution File Installer. The Distribution File Installer
screen appears.

4. On the bottom of the screen, click Conversion. Conversion files that are not appropriate for
use on the current FX Supervisory Controller are disabled.

5. Select the bold (non-disabled) .dist file and click Install

6. If astationis running, a dialog box appears indicating that FX Workbench must stop the
station prior to installing the .dist file.

7. Click Finish. The Installing Distribution screen appears and the installation begins. This
process may take several minutes.

8. Once the distribution file is installed, click Close.
9. Close FX Workbench 14.

Running Platform Daemon 6.x

About this task:
When you open the Platform Daemon 6.x, you are indicating the version of FX Workbench you want

to run.

® Note:

+ Certain antivirus programs may attempt to block you from running the Platform Daemon
software.

« Before running the platform daemon, be sure to close out any instances of FX Workbench
software.

Click Start > FX Workbench 6.x > Install Platform Daemon.

Installing a Backup 6.x Station

1. Open the platform for the FX Supervisory Controller. Use the default platform ID and
password (jci/FacilityExplorer61 or explorer).

2. Inthe Nav tree, select Platform > Distribution File Installer. The Distribution File Installer
screen appears.

3. Click Backups and select the backup .dist file to install. The backup file must match the FX
Supervisory Controller platform for the backup to be enabled in the list of backup files.

4. Click Install.

5. Click Next. If the backup has different TCP/IP settings than when the backup was created, a
screen appears prompting you to keep the existing TCP/IP settings or change them to what
was used when the backup was previously run.
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Figure 20: Restore TCP/IP Settings

- >

" Distribution File Installer

' Distribution File Installer
" Restore TCP/IP settings on remote host

The distribution file contains TCP/IP settings that may be used to update the

remote host:
Host Name ScotiFX30E
Domain (empty)

IPv4 Gateway 192.168.1.1
DMNSv4 Servers (empty)

Interfaces
ID end
Description Onboard Ethernet Adapter en0

Physical Address  00:01:F0:90:6C:CC
Adapter Enabled true
DHCPw4 false
IPv4 Address 192.168.1.147
IPv4 Subnet Mask 255.255.255.0
IPw6 Support true
IPv6 Enabled false
ID enl
Description Onboard Ethernet Adapter enl
Physical Address 00:01:F0:90:6C:CD
Adapter Enabled false
[[] Update the remote host's TCP/IP settings

| dsack || wea |[ Jrmish || © cancel |

6. Edit the settings as needed and click Finish. FX Workbench begins installing the backup of the
6.x station.

7. Click Close.

® Note: If you want to migrate back to FX Workbench 14.x, you need to obtain another
license for FX Workbench 14.x.

® Note: If you want to migrate back to FX Workbench 14.x, the platform credentials from
your previous migration were retained. You need to use those credentials. If you have
forgotten the default platform password, you can use the Serial Shell method to reset to
the default password.

Cleaning Tabbed Graphics

About this task:

Graphics with tabs at the bottom can still work in FX Supervisory Software 14.x. However, the way
these tabbed graphics were designed, the layout of the graphics within the tabs do not render
properly in FX Supervisory Software 14.x.

We recommend you remove the tabs to make them look more in line with FX Supervisory Software
14.x.

1. In FXWorkbench, open the property sheet of the device you want to change the graphic for.
2. Inthe PXFile field, note the .px file. This is the file that you need to edit.

3. Inthe controller's directory structure, navigate to Files > px and double-click the file noted in
Step 2. Notice the tabs at the bottom of the image.
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Figure 21: Tabbed Image
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4. Inthe view selector at the top right of the screen, select PxEditor.
Figure 22: PxEditor - All Tabs
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5. Toremove tabs from graphics and change the graphic to use a scroll pane instead of a border
pane, in the Widget Tree pane, expand BorderPane (Root) > TabbedPane (Content). Right-click
and delete all the LabelPane entries.

6. Inthe view selection, select Text Editor.

7. Go to the opening tags for the TabbedPane section of the Text Editor. Remove the following
lines:

<TabbedPane = "content" tabPlacement= "bottom">
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<LabelPane>

<Label name = "label" text = "Graphic"/>

8. Go to the closing tags for the TabbedPane section of the Text Editor.

9. Remove the following lines:
</LabelPane>
</TabbedPane>

10.

Properties of the graphic.

11. Select the following values:

To reset the canvasPane to orient to the top left and remove scaling, go to the CanvasPane

- In the halign field, select Left.
- In the scale field, select None.

- In the valign field, select Top.

12. Click OK.

Troubleshooting
Table 18: Migration Troubleshooting

Problem

Description

The Migration Results section in
the Migration Report file indicates
that .dist file did not complete
successfully. The Failure List
includes the following error
IllegalNameException: There

can be only one Admin role.

Although multiple roles with the name admin roles can
be configured and exist on an FX Workbench 6.x station,
the migration enforces only role with the name Admin
role for Migration. Delete any additional roles with the
name admin leaving only a single one remaining. Once
the additional Admin roles have been removed, run the
migration tool again.

® Note: The additional roles with an Admin name may
be hidden. To view and remove hidden roles, use the
Slot Sheet view of the UserService. Also, having the
names admin and Admin is considered having two
admin roles.

When running the Migration Tool, the
Client Password Test Fails.

The Client Password test ensures that passwords in the FX
Supervisory Software 6.x station can be decrypted for use
in FX Supervisory Software 14.x. A failure indicates that a
password could not be decrypted. If a failure occurs, re-
enter the password for the failed user in the running FX
Supervisory Software 6.x station and re-run the Migration
Tool.

The FX14UpgradeAssessmentTool
does not indicate whether the free
disk space, free heap memory, or
RAM disk size have passed.

For FX Supervisory Controllers, the
FX14UpgradeAssessmentTool must be run on the
controller itself.

® Note: Running the FX14UpgradeAssessmentTool on
a station running on a computer does not check for
free disk space, free heap memory, and RAM disk size.
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Table 18: Migration Troubleshooting

Problem

Description

When trying to access the web
user interface with Firefox™, there
is a pop-up dialog box that keeps
disappearing before I can interact
with it.

In the Add-ons section, set the Java Platform plug-in to
Always Activate. Close all instances of the browser,
restart the browser, and navigate to the web user
interface. The dialog box should now stay visible in order
for you to interact with it.

When trying to migrate my station,
you cannot log into the platform with
FX Supervisory Software 14.x

The host remembers credentials from a previous attempt
to migrate. For example, if you attempt to migrate a
station from FX Supervisory Software 6.x to FX Supervisory
Software 14.x and then decide to take it back to FX
Supervisory Software 6.x, the FX Supervisory Software 14.x
platform credentials are still retained in the host. When
you attempt to migrate to FX Supervisory Software 14.x the
second time, the required credentials are the ones defined
during the first attempt. If you have forgotten or do not
have those credentials, the defaults can be reset using a
Serial Shell connection to the host.

A station migrated to FX Supervisory
Software 14.x still needs a JAVA plug-
in for the browser.

Migrating a station does not automatically change user
profiles to the new HTML5HxProfile. You must change the
Default Web Profile to HTML5HxProfile for each user that
requires this functionality. For more details, see Changing
the Default Web Profile to Use the HTML5HxProfile.

When adding a new user or
modifying a password, the fields are
disabled in the user interface.

Starting with FX Supervisory Software 14.x, you are no
longer allowed to add or modify sensitive information
when using a non-secure connection. Refer to the FX
Workbench User Guide (LIT-12011149) for more information.
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Table 18: Migration Troubleshooting

Problem Description

This message appears because the security certificate
cannot be verified. Click the Advanced link, and then click
the Proceed to ###.###. ###.### (unsafe) link.

Browser displays Your connection
is not private.

An Install software error There may not be enough room on the controller. Go to
appears when installing the the Station Copier and, if there is an the FX Supervisory
distribution file. Install Controller 14 station on the controller, delete the station
Software: Failed from the controller.

The forecasting module used with FX Workbench Home
pages does not work with FX Supervisory Software Release
14. If you are trying to view a migrated station's Home

The following error appears when page using the HTML5HxProfile view, an error appears if
logging into a station using a web the Hx view in the forecasting information is not removed
browser. HTTP ERROR 500 from the view.

1.  Onthe Home page, select Edit Site Home from the

Problem accessing /ord/ . .
d view selector (top-right corner of the screen).

station%7Cskit:fxApp Reason:
2. Click and drag to select all of the Weather Forecast

java.baja.xml.SException: objects in the lower left are of the Hx graphic.
Unknow type ForecaseView 3. Press Delete.
[1ine80] . :
Change the view back to the appropriate Home page.
When asking if you want to save your changes, click
Yes.
Problem

My graphic no longer appears in my migrated station.

Description

FX Supervisory Software 6.x may have been able to render some file types which have certain
characters in the filename that are not recognized (see the following sections for guidelines around
naming). Rename your file with appropriate characters and re-link your graphic as necessary.

Component Naming

In a FX Supervisory Software 6.x station, you should name components using the following set of
rules:

« Only alphanumeric (A-Z, a-z, 0-9) and underscore (_) characters are used.

« Symbols characters (for example, %, &, ., #) are not allowed.

+ The first character in the name must be a letter (not a numeral).

+ Name must be unique for every component within the same parent component.

* Naming is case-sensitive. For example, zone21 and Zone21 are unique names.

® Note: Case differences among names affect the sorting of names in table-based views. The
sorting order uses capital letters (A-Z) first and lower case (a-z) following.
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To convey multiple word names without using spaces, naming conventions such as
CamelCase and underscores are often used, as needed. For example:

* Floor1 or Floor_1
* ReturnAirTemp or Return_Air_Temp
« Zone201_SAT or Zone_201_SAT

Escaped Names

You can name components in FX Workbench incorrectly, such as with spaces or other non-
alphanumeric characters. Further, various FX Supervisory Software 6.x drivers have learn features
to automate the creation of points, some of which (by default) may also have such incorrect names
—reflective of the native name of the source object. For example, a BACnet proxy point might have
the default name Zone 6 RH% that matches the actual (native) BACnet object’s name.

Be aware that the actual component name has all illegal characters escaped using a $ character,
along with the ASCII code for that character, in hexadecimal code. For example, a proxy point
has the name Zone$206RH$25, where the $20 replaces the space and the $25 replaces the %. You
can see these escaped names in the slot sheet of the component’s parent container. Or with the
component selected, look at its ord (shortcut Ctrl + L) to see the actual name.

For the most part, this escaped name scheme is transparent to users. When the name appears
to the user (for example, in the Nav tree, property sheet, wire sheet, or a point manager), the
component’s name is unescaped by replacing the code (for example, $20) with the actual ASCII
character (for example, a space). This way, the user sees Zone 6 R % and so on. This is the
component’s display name.

In some cases, escaped names lead to confusion. Avoid them or rename them, if possible. For
example, if you add history extensions to escaped-named points, you see those escape codes listed
for source points when accessing the History Ext Manager (although associated histories use the
display names). If you build Px pages and manually type the ords in Px widgets, you probably know
source points by display names only. If you manually type in an ord without the actual (escaped)
name, the widget binding fails with an error.

When using the HTML5HxProfile, the home page graphics created with previous versions of Facility
Explorer use a forecasting module. This module has not been updated for use with HTML5 and still
requires a Java plug-in. You can remove the components on the home page so that the rest of the
Home Page can appear without errors.

Related Documentation

Table 19: Related Documentation

For information about See document LIT or Part Number

The Features, Benefits, and FX Supervisory Controller Product

Specifications of the FX Supervisory Bulletin LIT-12011406
Controller
FX30E/F){60E Superv'/sory Controller Part No. 24-10174-115
Installation Instructions
How to Install the FX Supervisory FX70 Superwsory antro/ler Part No. 24-10564-17
Controller Installation Instructions

FX80 Supervisory Controller

Installation Instructions Part No. 24-10743-861
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Table 19: Related Documentation

The Features, Benefits, and
Specifications of the FX Server

For information about See document LIT or Part Number
FX Server Product Bulletin (6.x and
Earlier) LIT-12011122

FX Server Product Bulletin (14.x and | LIT-12012251

Later)

The Operation of FX Workbench FX Workbench User's Guide LIT-12011149
FX Supervisory Controller Family

How to Install FX Workbench Software Products Installation LIT-120711965
Instructions

Appendix

Migration Checklist

Action

Resources

Check the platform compatibility

Refer to the FX Supervisory Controller Upgrade and

and change users default profile to
HTML5HxProfile as desired.

L] list FO determine whether gr not the Migration Instructions (LIT-12011441).
desired platform can be migrated.
Refer to the FX Supervisory Controller Upgrade and
Migration Instructions (LIT-120114471).
[] Check driver, feature, and
application compatibility. Refer to the FX Workbench Pro Help.
Check directly with third-party vendors.
Refer to the FX Supervisory Controller Product
Bulletin (LIT-12011406).
Purchase the appropriate FX For North America, contact Johnson Controls
Supervisory Software 14 Software Product Software Sales at 1-414-525-7906 or
] Maintenance for FX Servers and FX | 1-800-275-5676, email jciorder@jci.com, or
Supervisory Controllers (to move fax to 1-800-356-1191. For answers to pricing
from 6.x to 14.x). questions, contact your channel account
manager. For sales queries outside North
America, contact Johnson Controls at http://
www.johnsoncontrols.com/contact-us.
Migrate FX Server and FX
] Supervisory Controller stations Refer to the FX Supervisory Controller Upgrade and

Migration Instructions (LIT-12011447).

FX Workbench 14.x Modules

Use this table as a reference when selecting modules during FX Workbench commissioning. This
modules listed below are the suggested modules needed for the JCI appliance on an FX80. All
modules sizes are approximate.
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jciorder@jci.com
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Table 20: FX Workbench 14.x Modules

Module Name Size Notes Module Name Size Notes
alarm-rt.jar i389.5 kitPx-ux.jar 11.7 KB
. 178.6 . . 121.8
alarm-ux.jar KB kitPx-wb.jar KB
. 488.6 . . 634.8
alarm-wb.jar KB kitPxHvac-wb.jar KB
app-rt.jar 21.1 KB kitPxHvacSmall.jar ifB
app-wb.jar 13.2 KB mobileThemeZebra- 24 KB
ux.jar
axvelocity-rt.jar 1383.5 mobile-ux.jar >19.9
y-rH KB ] KB
. . . . 195.5
axvelocity-wb.jar 28.9 KB mobile-wb.jar KB
backup-rt.jar 62.3 KB modbusAsync-rt.jar 24.2 KB
backup-wb.jar 23 KB modbusAsync-wb.jar 9.8 KB
. 1825.7 . 220.2
bacnet-rt.jar KB modbusCore-rt.jar KB
. 190.2 .
bacnet-ux.jar KB modbusCore-wb.jar 46.7 KB
. 311.5 .
bacnet-wb.jar KB modbusTcp-rt.jar 31.2KB
baja.jar iZBOOﬁ modbusTcp-wb.jar 11.3 KB
bajaScript-ux.jar i?;"l neql-rt.jar 82.5 KB
bajaui-wb.jar :<2880'7 net-rt.jar 63.6 KB
bajaux-rt.jar 28.5 KB niagaraDriver-rt.jar 360 KB
bajaux-ux.jar 89.5 KB niagaraDriver-wb.jar 1K883'6
S . . . . 133.5
basicDriver-rt.jar 59.3 KB niagaraVirtual-rt.jar KB
box-rt.jar i%&s niagaraVirtual-wb.jar 17.9 KB
bgl-rt.jar i689'3 nsh-wb.jar 20.83 KB
bql-ux.jar 63 KB obix-rt.jar 338'1
chart-rt.jar 14.9 KB obixDriver-rt.jar i284.4
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Table 20: FX Workbench 14.x Modules

Module Name Size Notes Module Name Size Notes
chart-wb.jar i(éO.B obixDriver-wb.jar 63 KB
. . 112.9
control-rt.jar 79.7 KB pdf-wb.jar KB
control-ux.jar 31.3KB platBacnet-rt.jar 25.9KB
control-wb.jar 22.5KB platCrypto-rt.jar 1K:39'4
. . 206.6
converters-rt.jar 129 KB platCrypto-wb.jar KB
. . 169.2 . 122.3
driver-rt.jar KB platDataRecovery-rt.jar KB
driver-ux.jar 47.7 KB platDataRecovery-wb.jar |37 KB
. . 106.8 .
driver-wb.jar KB platMstp-rt.jar 33.2KB
email-rt.jar 89.8 KB platPower-rt.jar 45.8 KB
email-ux.jar 33 KB platPower-wb.jar 28.3 KB
email-wb.jar 24.4 KB platSerial-rt.jar 23.3KB
entitylo-rt.jar 21 KB platSerialQnx-rt.jar 22.4 KB
file-rt.jar 97.6 KB platform-rt.jar i(I)BS.Z
. 234.4 . 491.3
fonts-rt.jar KB platform-wb.jar KB
fox-rt.jar ?(988'2 program-rt.jar 89.5 KB
x-rt.jar 129.6 rogram-wb.jar 230.5
gx-ux.jar 14.3 KB pxEditor-wb.jar 625 KB
gx-wb.jar 330'3 query-rt.jar 51 KB
. . 141.9
haystack-rt.jar 84.6 KB queryTable-wb.jar KB
. . 124.1 .
hierarchy-rt.jar KB report-rt.jar 66 KB
hierarchy-ux.jar 27.7 KB report-ux.jar 25.5KB
. . . 103.3
hierarchy-wb.jar 16.8 KB report-wb.jar KB
. . . 123.6
history-rt.jar 473 KB schedule-rt.jar KB
history-ux.jar 56.9 KB schedule-ux.jar 155 KB
. . 321.3 . 252.1
history-wb.jar KB schedule-wb.jar KB
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Table 20: FX Workbench 14.x Modules

Module Name Size Notes Module Name Size Notes
html-wb.jar 33.7KB search-rt.jar 47.2 KB
hx-wb.jar i782.9 search-ux.jar 60 KB
icons-ux.jar ing's search-wb.jar 15.7 KB
jciAutoTagging.jar | 80.2 KB z\lf\g for FX serial-rt.jar 23.3KB
jciN2ColorTec.jar 48KB jciBacnetColorTec.jar 72KB
jciBacnetParser.jar |78.4 KB serial-wb.jar 9.9 KB
- . 131.5 . .
jciCoreParser.jar KB silk-rt.jar 32.1 KB
jciDictionary.jar 407.5 smartTableHx-wb.jar 283.7
KB KB
- A 388.7 . . 163.2
jciFxDriver.jar KB tagdictionary-rt.jar KB
Lc;l;):DrlverAppllanc 549 KB tagdictionary-wb.jar 44.7 KB
- . . . 112.2
jciFxDriverHx.jar 291 KB template-rt.jar KB
jciMeters.jar 31.7 KB template-wb.jar i3854.7
NP 762.4 . . 949.4
jein2.jar KB themeLucid-ux.jar KB
- . 164.4 . 805.7
jciN2Parser.jar KB themeZebra-ux.jar KB
jciSpaces.jar :<886'7 tunnel-rt.jar 63.4 KB
- . 171.3 . . 538.6
jciSupport.jar KB wbutil-wb.jar KB
jciTagDictionary.jar |9.4 KB New for FX weather-rt.jar 180.5
14.6 KB
jciTools.jar 30.5KB weather-wb.jar i::j
- . 107.8 . 622.1
jciViews.jar KB web-rt.jar KB
jetty-rt.jar 76.4 KB webChart-rt.jar 31.6 KB
. . 1728.8 . 232.6
js-ux.jar KB webChart-ux.jar KB
. . . . 884.9
jxBrowser-wb.jar 50 KB webEditors-ux.jar KB
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Table 20: FX Workbench 14.x Modules

Module Name

Size Notes

Module Name

Size

Notes

kitControl-rt.jar

296.9
KB

wiresheet-wb.jar

203.4
KB

kitControl-ux.jar 101 KB

workbench-wb.jar

2510.3
KB

kitControl-wb.jar 11.9 kb

jciMgr.jar

55KB

Historical software revision numbering

Table 21: Niagara Version Used

SR

Key Identifying Features or
Changes

Niagara
Software
Versions

FX20
FX30E

FX40

FX60
FX60E

FX70

FX80

1.0

Initial release that introduced
the FX40 Supervisory
Controller, FX Server, and FX
Tools Supervisor Pro.

>

N

>
pad

3.0.88 N

N

>

N

>

N

>

N

>

1.1

Minor release that introduced
the update to the N2 Device
Manager, corrections to the
Variable Air Volume (VAV)
Modular Assembly (VMA)
occupancy enumerations, and
other minor bug fixes.

3.0.99 NA | NA X

NA |NA

NA

NA

1.2

Minor release that introduced
several enhancements and
bug fixes, including a new
tabbed structured system
graphic template, new
Schedule, Point Group, and
Link Managers, and FX Alarm
Portal.

3.0.106 NA NA X

NA NA

NA

NA

2.0

Major release that introduced
the FX20 and FX60 Supervisory
Controllers and accessories,
FX Server Limited, FX Server
driver options, FX Alarm Portal
client, and bug fixes to the N2
driver.

3.3.22 X NA |X

X NA

NA

NA
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Table 21: Niagara Version Used

o Niagara
= 7 LB NG FEARIER OO | e
Changes i
Versions

FX30E
FX60E
FX70
FX80

FX20
FX40
FX60

Minor release that introduced
the Wireless TEC Option card,
2.1 LX Series LON Controller 3331 (X NA |X  |X NA |NA |NA
configuration wizards, a New

Station wizard, and the Global

Point Extension Manager.

Minor release that introduced
support for iPhone® interface
or a similar sized graphical
user interface and the Point
Order field to the System
Library.

Major release that introduced
the FX22, FX62, and FX70
Supervisory Controllers and
accessories, FXRIO Remote
Input/Output (I/O) Module,
and General Packet Radio
Service (GPRS) Modem option
card.

2.2 3.3.31 X NA NA X NA |NA |NA

3.0 3.5.25 X NA NA X NA X NA

Minor release that introduced
the Assisted Device Import
3.1 feature, which supports the 3.5.34 X NA |[NA |X NA X NA
new FX-PC Programmable
Controllers.

Major release that introduced
the FX20, FX60, and FX70
Supervisory Controllers with
factory-installed BACnet® MS/
4.0 TP protocol driver licenses, 3.6.31 X NA |NA X X X NA
additional option cards, FX
Energy Suite, and FX20/FX60
basic demo supervisory
controllers.

Minor release that introduced
FX Server changes, BTL
Certification, and changes to

41 the method of FX Supervisor 3.6.47 X NA INA X X X NA
Controller family software
delivery and licensing.

4.1 Patch release 3.6.407 |X NA |[NA |X X X
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Table 21: Niagara Version Used

SR

Key Identifying Features or
Changes

Niagara
Software
Versions

FX20

FX30E

FX40

FX60

FX60E

FX70

FX80

5.0

Major release that introduced
revised graphic images and
templates, N2 device convert
manager, and new wizard
service for LX controllers.

3.7.106

N

>

N

>

5.1

Minor release that introduced
updates to FX Workbench.
These updates include Batch
Import, Simple Plant Standard
Graphics, Point Summary
Manager, Hardware Scan
Service, Graphic Sizing
Selection for Mobile Devices,
and Launch FX-PCT.

3.7.106

NA

NA

5.2

Minor release that introduced
the FX30E and FX60E
Supervisory Controllers. Also
introduced were updates

to tuning polices in FX
Workbench, N2 Help, and
Zoning application graphics.

3.7.106

NA

NA

53

Patch release

3.7.108

NA

NA

6.0

Major release that allows FX
Workbench to run on the
Niagara 3.8 platform.

3.8.38

NA

NA

NA

6.1

Minor release that introduced
updates to FX Workbench.
These updates include Spaces
and Equipment, Meters,
WT4000, and updates to the
Point Summary Manager.

3.8.38

NA

NA

NA

6.2

Patch release

3.8.41

NA

NA

NA

6.3

Minor release that introduced
updates to FX Workbench.
These updates include
support for the FX80,

Java® Web Start, support

for Windows® 10, and an
improved system usability.

3.8.111

NA

NR

NA

6.4

Patch release

3.8.213

NA

NR

NA

6.5

Patch release

3.8.311

NA

NR

NA
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Table 21: Niagara Version Used

o Niagara
= 7 LB NG FEARIER OO | e
Changes i
Versions

FX30E
FX60E
FX70
FX80

FX20
FX40
FX60

Minor release that provides
four functional fixes: a new
system property that allows
extending the timeout on
platform connection, a fix for
6.6 CCN Numeric override never |3.8.401 NA NR NA X X X X
stops writing, certificates

can now be approved for TLS
connections from WebStart
and the weather service can
now follow URI redirects

Major release that allows FX
Workbench to run on the
Niagara 4 platform.

14.0 4.0.22.16 |[NA |NR NA X X X NA

The jump from 6.x to 14.x
was intentional to align with
the Niagara software version
moving forward.

Minor release that adds
14.1 support for FX80 Supervisory |4.1.27.20 |NA NR NA X X X X
Controllers

Minor release that adds
Analytics 2.0 to FX Workbench.
There is also support for the
14.2 Alarm Portal, more robust 4.2.36.38 |NA |NR NA X X X X
FX Server data management
features, and support for FX80
legacy drivers.
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Table 21: Niagara Version Used

. Niagara
e ey [N FEERLIEa el | o e
Changes i
Versions

FX30E
FX60E
FX70
FX80

FX20
FX40
FX60

Minor release that introduced
two new RIO modules. The

release also adds new HTML5
14.3 screens to FX Workbench and 4.3.58.18 | NA NR NA X X X X
improved mobile web device

functionality.

Minor release adding

new HTMLS5 screens to FX
Workbench, improving mobile
web device functionality.
Minor change to the User
Service making the scheduled
access for users available
through the User Details
section. The JCI User manager
has been removed. Updating
an existing Nav file is through
the Toolsmenu.

14.4 4.473.6 |NA NR NA X X X X

Minor release that provides
eighteen functional fixes.
These included updated
firmware to solve FX80
WIFI modem failure, a fix
to Niagara Daemon Engine
Watchdog, and fixes to

14.4u1 | lexicons, hyperlinking, 44922 |NA |NR NA |X X Ix X
scrolling, and adding notes.

There was also
internationalization fixes to
lexicons and locales along
with web fixes to PDF Export,
Webchart, popups, PxIncludes
and HTML5 property sheets.

Note: NR stands for Not Recommended and SR stands for Software Release.

© ©

Note: Based on poor performance observed under lab conditions, we do not recommend that
you use the FX30E with software release 6.3 or any subsequent software release.

® Note: 14.4 is the final 14.x release that supports the FX30E, FX60E, and FX70. After 14.4, the 14.x
releases will only support the FX80. See Software Revision Numbering for the latest software
revision numbers.
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Product warranty

This product is covered by a limited warranty, details of which can be found at
www.johnsoncontrols.com/buildingswarranty.

Software terms

Use of the software that is in (or constitutes) this product, or access to the cloud, or hosted
services applicable to this product, if any, is subject to applicable end-user license, open-
source software information, and other terms set forth at www.johnsoncontrols.com/
techterms. Your use of this product constitutes an agreement to such terms.

Single point of contact

APAC

Europe

NA/SA

JOHNSON CONTROLS
C/O CONTROLS PRODUCT MANAGEMENT
NO. 32 CHANGJIJANG RD NEW DISTRICT

WUXI JIANGSU PROVINCE 214028

CHINA

JOHNSON CONTROLS
WESTENDHOF 3
45143 ESSEN

GERMANY

JOHNSON CONTROLS
507 E MICHIGAN ST
MILWAUKEE WI 53202

USA

Contact information

Contact your local branch office: www.johnsoncontrols.com/locations

Contact Johnson Controls: www.johnsoncontrols.com/contact-us

© 2021 Johnson Controls. All rights reserved. All specifications and other information shown were current as of document

revision and are subject to change without notice.



http://www.johnsoncontrols.com/buildingswarranty
https://www.johnsoncontrols.com/techterms
https://www.johnsoncontrols.com/techterms
http://www.johnsoncontrols.com/locations
http://www.johnsoncontrols.com/contact-us

	Contents
	Document Introduction
	Product discontinuations
	Concepts
	Ordering codes for Europe, Middle East, and Africa
	FX Supervisory Controllers
	FX Server
	(Release 6.x) FX Supervisor Controller Family Software DVD
        (LP-FXWB-COPY)
	Upgrading
	Migration
	Upgrade Pricing Policy
	Software Revision Numbering
	Software License Agreement
	Preventing Unauthorized Software Duplication or Usage
	License Files
	Part Numbers

	Detailed Procedures for Upgrading FX Workbench 6.x and Earlier
	Backing Up Your FX Supervisory Controller Station
	Preparing Your FX Supervisory Controller for Upgrading
	Checking for Minimum Memory Requirements

	Upgrading the FX Workbench Software
	Relicensing the FX Supervisory Controller
	Installing New Software into the FX Supervisory Controller
	Upgrading FX Server

	Detailed Procedures for Migrating to FX Supervisory Software 14.x
	Considering Platform Compatibility
	Considering Driver, Feature, and Application Compatibility
	Considering License Compatibility
	Example of an FX Supervisory Controller Migration
	FX Supervisory Software 14 Resource Requirements
	Checking for FX Supervisory Software 14 Resource Requirements

	Checking for Multiple Admin Roles
	Backing Up Your FX Workbench 6.x Station
	Running Platform Daemon 14.x
	Migrating the 6.x Station to Facility Explorer 14.x
	Installing the Distribution File
	Commissioning the Station
	Installing or Updating Licenses
	Setting the Enabled Runtime Profiles
	Specifying a Station to Install
	Installing Core Distribution Files
	Configuring TCP/IP Settings
	Updating the System Passphrase
	Specifying a Platform User to Replace the Factory-default Platform User
	Reviewing the Changes

	Changing the Default Web Profile to Use the HTML5HxProfile
	Viewing and Updating Metaspace
	Viewing Metaspace
	Updating Metaspace

	Upgrading FX Server to FX Supervisory Software 14
	Downgrading an FX80 from 14.x to 6.x
	Running Platform Daemon 6.x
	Installing a Backup 6.x Station

	Cleaning Tabbed Graphics
	Troubleshooting

	Related Documentation
	Appendix
	Migration Checklist
	FX Workbench 14.x Modules
	Historical software revision numbering

	Product warranty
	Software terms
	Single point of
        contact
	Contact information



